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1. はじめに 

「トラッキングデータ出力」とは、カメラの位置・向き・ズーム・フォーカスの情報を、リアルタイムで

ほかの機器へ送信する機能です。Virtual Production(VP)用のソリューションなどと連係すること

で、撮影映像と CG を合成して臨場感のある映像を作り出すことができます。 

本書では、OpenTrackIO プロトコルに関する詳細な技術情報を説明します。free-d プロトコルに

ついては、「カメラトラッキングデータ出力機能のインテグレーションマニュアル(free-d 編)」を参照

してください。 

 

OpenTrackIO プロトコルとは、VP における相互運用性の向上を目指して、SMPTE RIS-OSVP に

て設計されたオープンソースの規格です。 

ILME-FR7(以下、本機)は OpenTrackIO v1.0.1 の仕様に準拠しています。OpenTrackIO につい

ての詳細な内容やデータの数学的な仕様については、OpenTrackIO、および OpenLensIO の公

式ドキュメントを参照してください。 

 

本機より出力される OpenTrackIO のデータおよび関連する機能には、以下の特徴があります。 

 対応レンズを使用する場合、レンズキャリブレーションを実施することなくレンズに関する正確

なパラメーターを出力できます。 

 CGI または Web App を利用してイメージセンサーとステージ原点間のオフセットを設定でき

ます。カメラヘッドのパン・チルト角度とオフセットを基に、ステージ原点を基準としたイメージ

センサーの正確な位置を計算して出力します。 

 タイムスタンプとして使えるタイムコード情報を出力するため、同様のタイムコード情報を持つ

SDI 映像信号などのデータと同期を取ることができます。 

 

本機より出力される OpenTrackIO のデータの詳細は 3 章で説明します。 

CGI または Web App を使用した、トラッキングデータ出力機能の設定方法は 4 章で説明しま

す。 

推奨するカメラ設定については 5 章で説明します。 

本機能の使用に関する制約事項については 6 章で説明します。 

 



© 2026 ソニー株式会社                       
 

 

ILME-FR7 | カメラトラッキングデータ出力機能のインテグレーションマニュアル (OpenTrackIO 編) 

 

 

  3 

2. 対象モデルとバージョン 

製品名 対応するソフトウェアバージョン 

ILME-FR7 Ver. 4.00 以降 

 

3. 出力データ 

本章では、本機より出力される OpenTrackIO のデータについて説明します。 

OpenTrackIO 出力データはヘッダー部とペイロード部で構成されています。これが UDP パケット

として送信されます。 

図 1: OpenTrackIO データの構成 

 

 
OpenTrackIO の仕様では、出力データを任意のデータサイズ(バイト数)でセグメントに分割し、複

数パケットで出力することも可能ですが、本機では分割せず 1 つのパケットで出力します。 

3.1. ヘッダー 

以下の要素で構成されています。バイトオーダーはビッグエンディアンです。 

 Identifier: 識別子です。固定値“OTrk”の ASCII コード(0x4F54726B)になります。 

 Reserved: 予約領域です。常に 0 になります。 
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 Encoding: ペイロードのエンコーディング形式です。0x01(JSON 形式)または 0x02(CBOR 形

式)のいずれかになります。 

 Sequence number: パケット毎にカウントアップされる番号です。初期値は乱数で以降連番に

なります。最大値(65535)の次は 0 に戻ります。 

 Segment offset: ペイロード先頭からのセグメントのオフセット量です [単位:バイト]。分割が

ないので常に 0 となります。 

 Last segment flag: 最終セグメントを示すフラグです。分割がないので常に１となります。 

 Payload length: ペイロード部のデータサイズとなります [単位:バイト]。 

 Checksum: ヘッダー部(Checksum の 2 バイト分を除く 14 バイト分)とペイロード部を

Fletcher-16 で計算した値となります。Fletcher-16 の剰余演算は modulo 256 で計算しま

す。 

3.2. ペイロード 

ペイロード部には下記の 6 種類の情報が含まれます。 

表 1: ペイロード部に含まれるデータ 

level1 内容 

static フレームレート、記録画素数などの静的な情報 

timing トラッキングデータの出力レートやタイムコードの情報 

lens レンズに関連する情報 

protocol OpenTrackIO のバージョンに関連する情報 

sourceNumber 出力ソースを示す番号の情報 

transforms イメージセンサーの位置・向きに関連する情報 

 

3.2.1. static 

レンズが装着されていない場合、static/lens データは出力されません。 

表 2: static データの説明 

level1 level2 level3 level4 内容 

static camera 

captureFrameRate 
num 撮像フレームレートの分子 

denom 撮像フレームレートの分母 

activeSensorPhysicalDimensions 

*1 

height フィルムバックの縦方向サイズ [mm] 

width フィルムバックの横方向サイズ [mm] 

activeSensorResolution 
height 縦方向の記録画素数 [pixel] 

width 横方向の記録画素数 [pixel] 
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*1 以下の機能の動作を反映して、height, width の値が変化します。 

 イメージャースキャンモード 

 レンズのブリージング補正 

 全画素超解像ズーム 

3.2.2. timing 

表 3: timing データの説明 

level1 level2 level3 level4 内容 

timing 

sampleRate 
num - トラッキングデータの出力周波数の分子 

denom - トラッキングデータの出力周波数の分母 

timecode hours - タイムコード（時） 

minutes - タイムコード（分） 

seconds - タイムコード（秒） 

frames - タイムコード（フレーム） 

frameRate num タイムコードフレームレートの分子 

denom タイムコードフレームレートの分母 *1 

subFrame - タイムコードサブフレーム 

*1 ドロップフレーム設定に応じて変化します。カメラメニューの[TC/Media] > [Timecode] > [TC 

Format] が[DF]の場合は 1001、[NDF]の場合は 1000 となります。 

  

make - 
カメラのメーカー名。“Sony”が出力さ

れます。 

model - 
カメラのモデル名。“ILME-FR7”が出

力されます。 

serialNumber - カメラのシリアルナンバー 

firmwareVersion - カメラのソフトウェアバージョン 

label - 
CGI または Web App で設定した 

Camera Name の文字列 

isoSpeed - ISO 感度 

shutterAngle - シャッター開角度 [degree] 

lens 

make - 

レンズのメーカー名。対応レンズの場

合“Sony”が出力されます。それ以外

のレンズでは“N/A”が出力されま

す。 

model - レンズのモデル名 

serialNumber - レンズのシリアルナンバー 

firmwareVersion - レンズのソフトウェアバージョン 

nominalFocalLength - レンズの公称焦点距離 [mm] 
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3.2.3. lens 

レンズが装着されていない場合、lens データは出力されません。 

ご注意 

• 対応レンズは機能互換情報(カメラトラッキングデータ出力)をご確認ください。対応レンズ以外では、

lens データの精度が低下する場合があります。 

• フォーカス位置が最短撮影距離より近い位置、または無限遠を超える位置にある場合、lens データ

の精度が低下します。 

• レンズキャリブレーション時と撮影時で、スライド式フォーカスリングのスライド位置(「AF/MF」、「Full 

MF」)やマクロ切り替えリングの位置を切り替えずにご使用ください。 

• 最短撮影距離がズーム位置によって変化するレンズでは、ズームによって lens/encoders/focus およ

び lens/rawEncoders/focus の値が変化する場合があります。 

• 広角レンズを使用する場合、歪曲収差の影響により誤差が生じることがあります。 

• lens データは設計値に基づいて算出しているため、レンズ個体差によりばらつきが生じる場合があり

ます。 

表 4: lens データの説明 

level1 level2 level3 level4 level5 内容 

lens distortion *1 [0] model  歪係数のモデル名。

“Brown-Conrady D-U”が出

力されます。 

radial [0] 半径方向の歪係数 k1。0 が

出力されます。 

[1] 半径方向の歪係数 k2。0 が

出力されます。 

[2] 半径方向の歪係数 k3。0 が

出力されます。 

[3] 半径方向の歪係数 k4。0 が

出力されます。 

[4] 半径方向の歪係数 k5。0 が

出力されます。 

[5] 半径方向の歪係数 k6。0 が

出力されます。 

tangential [0] 円周方向の歪係数 p1。0 が

出力されます。 

[1] 円周方向の歪係数 p2。0 が

出力されます。 
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encoders focus - - 正規化された focus のエンコ

ーダ値。無限遠側で小さな

値となります。 

iris - - 正規化された iris のエンコー

ダ値。開放側で小さな値とな

ります。 

zoom - - 正規化された zoom のエンコ

ーダ値。広角側で小さな値と

なります。 

entrancePupilOffset 

*2 

- - - イメージセンサーから入射瞳

までの距離[m] 

fStop - - - F 値 

pinholeFocalLength - - - ピンホールカメラモデルの焦

点距離 [mm] 

focusDistance - - - イメージセンサーからのフォ

ーカス距離[m]。表現可能な

最長距離は 65536m です。

無限遠では 65536 が出力さ

れます。 

projectionOffset x - - 画像中心からの光学中心の

横方向のズレ[mm]。0 が出

力されます。 

projectionOffset y - - 画像中心からの光学中心の

縦方向のズレ[mm]。0 が出

力されます。 

rawEncoders focus - - focus のエンコーダ値。無限

遠側で小さな値となります。 

iris - - iris のエンコーダ値。開放側

で小さな値となります。 

zoom - - zoom のエンコーダ値。広角

側で小さな値となります。 

*1 OpenTrackIO 形式のトラッキングデータ使用時はレンズの自動歪曲収差補正設定を Auto で

使用してください。 

*2 対応レンズ以外では出力されません。 

3.2.4. protocol 

表 5: protocol データの説明 

level1 level2 level3 内容 

protocol name - プロトコル名。“OpenTrackIO”が出力されます。 

version [0,1,2] OpenTrackIO のバージョン情報。“[1,0,1]”が出力されます。 
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3.2.5. sourceNumber 

表 6: sourceNumber データの説明 

level1 内容 

sourceNumber CGI または Web App で設定した Source Number の値 

 

3.2.6. transforms 

各軸の向き、および回転の順序は OpenTrackIO の定義に準拠します。 

表 7: transforms データの説明 

level1 level2 level3 level4 内容 

transforms [0] translation x イメージセンサーの位置 (X) [m] 

y イメージセンサーの位置 (Y) [m] 

z イメージセンサーの位置 (Z) [m] 

rotation *1 pan イメージセンサーの回転 (Pan) [degree] 

tilt イメージセンサーの回転 (Tilt) [degree] 

roll イメージセンサーの回転 (Roll) [degree] 

id - transforms の ID。“camera”が出力されます。 

*1 カメラヘッドのパン・チルト角度やオフセット設定によっては、pan, tilt, roll の出力値が非連続

的に変化する場合があります。pan, tilt, roll で表されるカメラの向きは連続的に変化しますの

で、必ず pan, tilt, roll の 3 つを組み合わせて使用してください。 
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4. トラッキングデータ出力機能の設定 

本章では、トラッキングデータ出力機能に関連する設定について説明します。各設定項目は

CGI を使用して制御されます。CGI コマンドの入力、または Web App を使用して設定が可能で

す。 

4.1. 関連用語 

本節では、設定パラメーターやオフセット設定に関連する用語について説明します。 

4.1.1. ホーム位置 

カメラヘッドのパン・チルトが 0°の状態を指します。図 2 に本体のデスクトップ設置時、図 3 に天

吊り設置時におけるカメラ本体のパン・チルトの角度の範囲を示します。図中に 0°で示されてい

る位置がホーム位置となります。 

パン・チルトをホーム位置に戻すには、Web App のカメラ操作部の (Others)タブにある

(パン・チルトホーム)ボタンを押します。 
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図 2: デスクトップ設置時におけるカメラヘッドのパン・チルトの角度の範囲 

 
図 3: 天吊り設置時におけるカメラヘッドのパン・チルト角度範囲 
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4.1.2. ステージ原点 

現実空間と CG の仮想空間を重ね合わせて共通の座標系を定義した領域をステージと呼びま

す。その座標系の原点（0,0,0）をステージ原点と呼びます。 

4.1.3. イメージセンサー位置 

カメラヘッドのイメージセンサーの中心をイメージセンサー位置とします。イメージセンサー位置

の測定は、図 4 の寸法図を参考にしてください。＋がイメージセンサー位置となります。 

OpenTrackIO ではステージ原点を基準としたイメージセンサーの位置・向き情報を出力するた

め、Web App で初期値を設定することができます。詳細は「4.4 トラッキングデータのオフセット設

定」で説明します。 
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図 4: ILME-FR7 の本体寸法とイメージセンサー位置 

 

4.2. CGI を利用した設定 

本節では、CGI を利用してトラッキングデータ出力機能に関する各種設定を取得、変更する方法を

説明します。 

4.2.1. CGI コマンド 

以下に示す HTTP URI でトラッキングデータ出力機能に関する各種設定の取得ができます。 

イメージセンサー位置 
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取得形式として、通常形式と JS パラメーター形式を選択できます。URI にアクセスする際の 

HTTP メソッドは GET のみ許可されています。認証は HTTP ダイジェスト認証（RFC 2617）で

おこない、カメラに対する管理者権限が必要です。 

 

[通常形式] 

http://<ip_address>/command/inquiry.cgi?inq=trackingdata 

 
[JS パラメーター形式] 

http://<ip_address>/command/inquiry.cgi?inqjs=trackingdata 

 
以下の HTTP URI でトラッキングデータ出力機能に関する各種設定を変更できます。 

http://<ip_address>/command/trackingdata.cgi?<parameter1>=<value1>[&<parameter2>=<value2>&...] 

 
HTTP クエリ文字列の仕様に基づき、“<parameterN>=<valueN>” の文字列を “&” で連結する

ことで複数のパラメーターを同時に制御できます。 

4.2.2. CGI パラメーター 

トラッキングデータ出力機能の各種設定項目に対応する CGI パラメーターについて、表 8 で説

明します。 

表 8: CGI パラメーターの一覧 

パラメーター 値 概要 

TrackingDataCameraID 
0～255 

(デフォルト値:255) 

free-d D1 形式のトラッキ

ングデータの Camera ID 

TrackingDataSourceNum 
0～255 

(デフォルト値:1) 

OpenTrackIO 形式のトラッ

キングデータのソース番号 

TrackingDataOutputNum 4(読み取り専用) 
ユニキャストの送信先とし

て設定可能な最大数 

TrackingDataDestination<N> 
“on” / “off” 

(デフォルト値:“off”) 

<N>番目の送信先へのトラ

ッキングデータ送信設定 
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TrackingDataDestinationAddress<N> 
IPv4 アドレス形式の文字列 

(デフォルト値:空文字) 

<N>番目の送信先のアドレ

ス 

TrackingDataDestinationPort<N> 
1024～65534 

(デフォルト値:40000) 

<N>番目の送信先のポート

番号 

TrackingDataProtocolOutputNum (読み取り専用) 

個別に送信データのプロト

コルを設定できる送信先

の数 

TrackingDataProtocol<N> 
“freed_d1” / “opentrackio” 

(デフォルト値：“freed_d1”) 

<N>番目の送信先のトラッ

キングデータのプロトコル 

TrackingDataEncoding<N> 
“cbor” / “json” 

(デフォルト値：“cbor”) 

<N>番目の送信先のトラッ

キングデータのエンコーデ

ィング形式。OpenTrackIO

の場合のみ有効 

TrackingDataMulticastOutputNum (読み取り専用) マルチキャストの送信先と

して設定可能な最大数 

TrackingDataMulticastDestination1 “on” / “off” 

(デフォルト値:“off”) 

トラッキングデータのマル

チキャスト送信設定 

TrackingDataMulticastDestinationAddress

1 

IPv4 アドレス形式の文字列  

(デフォルト値:239.135.1.1) 

マルチキャスト送信先のア

ドレス 

TrackingDataMulticastDestinationPort1 1024～65534 

(デフォルト値:55555) 

マルチキャスト送信先のポ

ート番号 

TrackingDataMulticastProtocol1 “freed_d1” / “opentrackio” 

(デフォルト値：“opentrackio”) 

マルチキャスト送信するト

ラッキングデータのプロトコ

ル 

TrackingDataMulticastEncoding1 “cbor” / “json” 

(デフォルト値：“cbor”) 

マルチキャスト送信するト

ラッキングデータのエンコ

ーディング形式。

OpenTrackIO の場合のみ

有効 

TrackingDataMulticastTtl1 1～255 

(デフォルト値:64) 

マルチキャスト送信の TTL

値 

TrackingDataImagerOffsetX -2147483647～2147483646 

(デフォルト値:0) 

ステージ原点に対するイメ

ージセンサー位置の X 軸

方向のオフセット 

(単位:1/100mm) 
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TrackingDataImagerOffsetY -2147483647～2147483646 

(デフォルト値:0) 

ステージ原点に対するイメ

ージセンサー位置の Y 軸

方向のオフセット 

(単位:1/100mm) 

TrackingDataImagerOffsetZ -2147483647～2147483646 

(デフォルト値:0) 

ステージ原点に対するイメ

ージセンサー位置の Z 軸

方向のオフセット 

(単位:1/100mm) 

TrackingDataImagerOffsetRotationZ -2147483647～2147483646 

(デフォルト値:0) 

ステージ原点に対するイメ

ージセンサー位置の Z 軸

まわりの回転(Pan) 

(単位:1/106 degree) 

TrackingDataImagerOffsetRotationX -2147483647～2147483646 

(デフォルト値:0) 

ステージ原点に対するイメ

ージセンサー位置の X 軸

まわりの回転(Tilt) 

(単位:1/106 degree) 

TrackingDataImagerOffsetRotationY -2147483647～2147483646 

(デフォルト値:0) 

ステージ原点に対するイメ

ージセンサー位置の Y 軸

まわりの回転(Roll) 

(単位: 1/106 degree) 

TrackingDataSlideBaseEnable “on” / “off” 

(デフォルト値:“off”) 

スライドベースの位置目盛

の設定が有効か 

TrackingDataSlideBaseScaleValue 0～9670 

(デフォルト値:0) 

スライドベースの位置目盛 

(単位:1/100mm) 

4.3. Web App を利用した設定 

本節では、Web App を利用したトラッキングデータ出力機能の設定方法を説明します。Web メニュ

ーの [Technical] > [Tracking Data Output] では、主に出力に関連する設定をおこないます。

[Technical] > [Tracking Data] では、トラッキングデータに含まれるパラメーターに関する設定をお

こないます。 
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4.3.1. Tracking Data Output 

図 5 に、Web App の Tracking Data Output 設定ページを示します。 

 
図 5: Tracking Data Output 設定ページ 

 

 
[Unicast Destinations] はトラッキングデータのユニキャスト送信についての設定です。最大 4 つの

送信先にトラッキングデータを送信できます。表 9 で、それぞれの設定値を説明します。 

 

表 9: Unicast Destinations の設定項目 

項目 設定値 概要 

IPv4 Address IPv4 アドレス トラッキングデータの送信先 IP アドレスを設定します。 

Port 1024～65534 

(デフォルト値:40000) 

トラッキングデータの送信先ポート番号を設定します。 
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Protocol free-d D1 / OpenTrackIO 

(デフォルト値:free-d D1) 

トラッキングデータのプロトコルを設定します。 

Encoding JSON / CBOR プロトコルが OpenTrackIO の場合のエンコーディング

形式を設定します。 

Output On / Off 

(デフォルト値:Off) 

トラッキングデータを送信するかどうかを設定します。 

 

[Multicast Destination] はトラッキングデータのマルチキャスト送信についての設定です。表 10

で、それぞれの設定値を説明します。 

 

表 10: Multicast Destination の設定項目 

項目 設定値 概要 

IPv4 Address *1 IPv4 アドレス 

(デフォルト値:239.135.1.1) 

トラッキングデータの送信先 IP アドレスを設定しま

す。 

Port 1024～65534 

(デフォルト値:55555) 

トラッキングデータの送信先ポート番号を設定しま

す。 

Protocol free-d D1 / OpenTrackIO 

(デフォルト値:OpenTrackIO) 

トラッキングデータのプロトコルを設定します。 

Encoding JSON / CBOR 

(デフォルト値:CBOR) 

プロトコルが OpenTrackIO の場合のエンコーディン

グ形式を設定します。 

Output On / Off 

(デフォルト値:Off) 

トラッキングデータを送信するかどうかを設定しま

す。 

Source Number 

(OpenTrackIO) 

*1 *2 

0～255 

(デフォルト値:1) 

トラッキングデータのソース番号を設定します。ユニ

キャスト送信・マルチキャスト送信両方の

sourceNumber に反映されます。 

TTL 1～255 

(デフォルト値:64) 

マルチキャスト送信の TTL 値を設定します。 

*1 OpenTrackIO では表 11 に示すように IPv4 Address の第 4 オクテットを Source Number と同一

にすることが推奨されています。 

*2 OpenTrackIO では Source Number を 1～200 の範囲に設定することが推奨されています。 
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表 11: 推奨するマルチキャストアドレス 

第 1 オクテット 第 2 オクテット 第 3 オクテット 第 4 オクテット 

239 135 1 Source Number 

4.3.2. Tracking Data 

図 6 に、Web App の Tracking Data 設定ページを示します。 

 

図 6: Tracking Data 設定ページ 

 

[Image Sensor to Stage Offset]と[Slide Base Scale Value]に入力された値は、カメラヘッドのパン・チ

ルト角度を加味したうえで出力データの transforms へ反映されます。これらの設定項目についての

詳細は、「4.4 トラッキングデータのオフセット設定」で説明します。表 12 および表 13 で、それぞれ

の設定値を説明します。 
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表 12: Image Sensor to Stage Offset の設定項目 

項目 設定値 概要 

X -21474836.47～21474836.46 

(デフォルト値:0.00) 

X 軸方向のオフセットを設定します。（単位：mm） 

Y -21474836.47～21474836.46 

(デフォルト値:0.00) 

Y 軸方向のオフセットを設定します。（単位：mm） 

Z -21474836.47～21474836.46 

(デフォルト値:0.00) 

Z 軸方向のオフセットを設定します。（単位：mm） 

Rotation Z -2147.483647～2147.483646 

(デフォルト値:0.000000) 

Z 軸まわりの回転を設定します。（単位：degree） 

Rotation X -2147.483647～2147.483646 

(デフォルト値:0.000000) 

X 軸まわりの回転を設定します。（単位：degree） 

Rotation Y -2147.483647～2147.483646 

(デフォルト値:0.000000) 

Y 軸まわりの回転を設定します。（単位：degree） 

 

表 13: Slide Base Scale Value の設定項目 

項目 設定値 概要 

Setting On / Off (デフォルト値:Off) Scale Value 設定を有効にします。 

Scale Value 0.00～96.70 (デフォルト値:0.00) 
スライドベースの位置目盛の値を設定します。 

(単位:mm) 

4.4. トラッキングデータのオフセット設定 

本節では、カメラの位置・向き情報を正確に計算するための[Tracking Data]の[Image Sensor to 

Stage Offset]および[Slide Base Scale Value]の設定方法について説明します。 

[Image Sensor to Stage Offset]には、カメラヘッドがホーム位置にある状態で、ステージ原点から

イメージセンサー位置までの距離および角度を入力します。 

図 7 で示すように、軸の向きは OpenTrackIO の定義に合わせています。イメージセンサー面を

正面として、それぞれ X 軸：右向きを正、Y 軸：正面向きを正、Z 軸：上向きを正とします。回転は

X 軸・Y 軸・Z 軸いずれも時計回りを正とします。 
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図 7: Image Sensor to Stage Offset の各軸の向き 

 
 

[Slide Base Scale Value]は、イメージセンサー位置とカメラヘッドのパン・チルトの回転中心位置

の差分を計算に加味するための設定です。[Setting]が Off の場合、イメージセンサー位置とパ

ン・チルトの回転中心位置が同じとみなして計算します。[Setting]が On の場合、[Scale Value]に

スライドベースの位置目盛の値を設定することで、イメージセンサー位置とパン・チルトの回転中

心位置の差分をイメージセンサー位置計算に反映します。 

イメージセンサーとパン・チルトの回転中心の Y 軸方向の位置の差分は以下の式で計算されま

す。 

 

位置の差分 (mm) = 87.3 – Scale Value 
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図 8: スライドベースの位置目盛 

 
 

ご注意 

• スライドベース上でカメラヘッドの位置を変更した場合は、[Image Sensor to Stage Offset]および[Slide 

Base Scale Value] > [Scale Value]を再設定してください。 
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5. 推奨するカメラ設定 

本章では OpenTrackIO を使用する際に推奨されるカメラ設定について説明します。 

5.1. レンズの自動歪曲収差補正設定 

カメラメニューの [Technical] > [Lens] > [Distortion Comp.] で、レンズの自動歪曲収差補正を

Auto に設定してください。 

5.2. イメージスキャンモードの設定 

APS-C フォーマット専用のレンズを装着している場合は、Web メニューの [Project] > [Rec 

Format] > [Imager Scan Mode] を S35 に設定してください。S35 以外に設定した場合、トラッキ

ングデータの lens/pinholeFocalLength に正しい値が出力されません。 

5.3. タイムコード設定 

カメラメニューの [TC/Media] > [Timecode] > [Run] で、Free Run に設定してください。 

Free Run に設定することでタイムコードが常に歩進し、トラッキングデータのタイムスタンプ情報と

して使用できます。 

5.4. Camera Name 設定 

Web メニューの [Network] > [Camera Name]で、カメラ毎に任意の名前を 0～8 文字の英数字で

設定できます。 

設定した名前は、トラッキングデータの static/camera/label に反映され、受信側でどのカメラか

らの出力データなのかを特定するのに役立ちます。 
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5.5. Output Format 設定 

Web メニューの [Monitoring] > [Output Format] > [SDI/HDMI] で、SDI および HDMI 端子の

出力フォーマットを設定できます。 

表 14 のとおり、設定されているシステム周波数と SDI/HDMI 出力フォーマットによって、トラッキ

ングデータの送信周波数は変化します。 

SDI/HDMI 出力フォーマットが 1920×1080PsF、1920×1080i、もしくは SDI RAW 出力時は、トラ

ッキングデータの送信周波数がシステム周波数の 2 倍となる場合があり、このとき一部のデータ

はシステム周波数に従い更新されます。 

システム周波数とトラッキングデータ送信周波数が一致する設定を推奨します。それによって、フ

レームごとにトラッキングデータが更新されます。 

 

表 14: トラッキングデータの送信周波数一覧 

システム周波数 SDI/HDMI 出力フォーマット トラッキングデータ出力周波数 

59.94Hz 設定によらず一定 59.94Hz 

50Hz 設定によらず一定 50Hz 

29.97Hz 

 

1920×1080PsF / 1920×1080i 

もしくは SDI RAW 出力時 

59.94Hz 

それ以外 (推奨) 29.97Hz 

25Hz 

 

1920×1080PsF / 1920×1080i 

もしくは SDI RAW 出力時 

50Hz 

それ以外 (推奨) 25Hz 

24Hz 設定によらず一定 24Hz 

23.98Hz 

 

1920×1080PsF 47.96Hz 

それ以外 (推奨) 23.98Hz 

5.6. レンズの手ブレ補正 

レンズの手ブレ補正動作はトラッキングデータに反映されません。レンズに手ブレ補正スイッチが

付いている場合、OFF に設定してご使用ください。手ブレ補正スイッチが付いていないレンズの

場合、カメラメニューの[Shooting] > [SteadyShot] > [Setting]を Off に設定してご使用ください。 
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6. 制約事項 

本章では制約事項について説明します。 

6.1. スロー&クイックモーション機能有効時の制約 

スロー&クイックモーション機能を有効にした場合、トラッキングデータの変化のタイミングと送信の

タイミングにズレが生じます。安定したトラッキングデータの送信のためには、スロー&クイックモー

ション機能は Off での使用を推奨します。 

6.2. GENLOCK 同期確立中のトラッキングデータ送信 

外部同期信号がカメラに到達してから、カメラがその信号にロック（同期）するまでには、一定の時

間が必要です。この間は、トラッキングデータの送信が一時停止されます。同期が完了すると、ト

ラッキングデータの送信を自動的に再開します。 

6.3. 映像および音声のストリーミングとの同時使用 

本機には映像および音声のストリーミング機能があります。ストリーミングを行うと、ネットワーク帯

域が占有され、以下のような症状が発生する可能性があります： 

• トラッキングデータ伝送の遅延 

• トラッキングデータ送信間隔の揺らぎ 

6.4. パン・チルトロックレバー 

パン・チルトロックレバーが LOCK 位置にある場合は、実際のカメラヘッドのパン・チルト角度に

関わらず、カメラヘッドのパン・チルト角度が 0°であるとして位置・向きを計算し、トラッキングデ

ータの transforms に反映します。 
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6.5. ユーザー操作による性能悪化 

以下の操作中は、トラッキングデータの出力が遅延したり、出力内容が更新されないことがありま

す。 

 カメラのセットアップメニューを表示中 

 記録クリップのサムネイル一覧を表示中 

 記録クリップを再生中 

 Web App の設定画面で各種設定の変更中、または処理の実行中 
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7. 商標について 

 HDMI、High-Definition Multimedia Interface、および HDMI ロゴは、米国およびその他の

国における HDMI Licensing Administrator, Inc.の商標または登録商標です。 

 その他の各社名および各商品名は各社の登録商標または商標です。なお、本文中では

™、®マークは明記していません。 
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 変更履歴 

変更日 バージョン 変更内容 

2026 年 

2 月 12 日 

1.00 初版 
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